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Installation Instructions and Cautions

PLEASE NOTE: MAS 90 must already be installed on your
system before installing any 11G enhancement. If not already
done, perform your MAS 90 installation and setup now; then
allow any updating to be accomplished automatically.

Once MAS 90 installation and file updating is complete, you may
install your 11G enhancement product by following the procedure
below.

Wait! Before You Install - Do You Use CUSTOM OFFICE?
THIS IS AN IMPORTANT CAUTION: If you have
Custom Office installed, and if you have modified any MAS
90 screens, you must run Customizer Update after you do
an enhancement installation.

But wait! BEFORE you run Customizer Update, it isvery
important that you print all of your tab lists. Running
Customizer Update will clear all Tab settings; your printed tab
list will help you to reset your Tabsin Customizer Update.
Custom Office isinstalled on your systemif thereisan
asterisk in the title bar of some of the screens. The asteri
indicates that the screen has been changed.

Ei * gales Order Entry (111) 06/12 /2006

Order Mumber Q\\J E% @ @ @ @ I -----

1. Header I 2. Address ] 3. Lines ] 4. Tatals

Order D ate ' Order Type
Customer Mo il [ '
Ship To Addr
Termsz Code
Cloim Ftmbm . Chir Wiz

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

An asterisk in a
window’s title bar
indicates that the
screen has been
modified. This
means that
Custom Office is
installed.

Follow all the
instructions on
this page before
you run
Customizer
Update!
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Registering IIG products

I1G Enhancement should be registered to be able to useit.
If registration is not performed, the enhancement will work
in ademo mode for alimited time period. The registration
can be still done during the demo period.

Select the 11G Product Registration program under the
Library Master Setup menu of the MAS 90.

If thisoption is not listed under the Library Master Setup
menu, go to the main menu, and select Run from the File
menu. Typein SVIIGR and click OK.

Gﬂ-IIG Master Developer Enhancement Registration 2 =10 x|

Feqistered Customer

G

~—Reaqigtration [nformatiorn
Reseller Mame

Senial Mumber
Cuztomer Mumnber
|dzer Key

Froduct Key

IRRRRAN

22L2222A2
33333333333333333332

L]

] 25505 55a5h L]

E nhancement

IIG Enhancement Name

Erhanc:
15 Eranc

al

Level

4.50

Lewel

Feleaze Date  Sernial Mumber Unlocking k.ey

BbABMLALAAAS S, | | BEEEBE

Release Date

| i

[ Frint Reaqistration Farm l

| s | aBC | D9/27/2011

Enter Serial Number and Unlocking Key provided by I1G,

and click OK.

If multiple I1G Enhancements are installed, Serial Numbers
and Unlocking Keys should be entered for each

enhancement.

Use the Print Registration Form button to print
I1G Registration Form.

INFORMATION INTEGRATION GROUP 877.475.4092
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Introduction

The RF Warehouse Automation enhancement for MAS
90 isthe tool you need to serve your customers more
effectively. Your team will be able to enter shipping data
and receipts of goods while on the road with their Radio
Frequency device with Windows CE — saving time and
ensuring accuracy.

By connecting salespeople who are in remote locations to
MAS 90 software, your company will bein a strategic
position to serve your customers more quickly and more
efficiently.

If you have salespeople who are traveling, Radio Frequency
solutions can be a valuable addition to your company.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
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Before you run RFS

Before you start using RF Warehouse Automation, you
must modify its desktop shortcut to be ableto runiit.

Map the Network drive where your MAS90 system is
located.

Right-click your MAS90 icon on the desktop, and select
the Properties in the pop-up menu. Go to the Shortcut tab.

In the Target field, type your path\M A S90\Home\pvxwin32.exe -hd
.\Mauncher\sota.ini ..\soa\RFS_Startup.m4p.

(where your path stays for the path to your MAS 90/200 system, e.g.
D:\MAS\MasA50\Rfs).

RFS 450 MAS 90 Properties e

General  Shortout |Eu:um|:uatibilit_l,ll SEcurit_l,II

RF5 450 MAS 30
d

T arget type: Applicatian

T arget location: Home

Target: I'u:her"usu:uta.ini RELEVE RS startup. mdp EASIEREE

Start i Iu:l:"-.M.-’-'-.S W azd50NRFSWMAS S0 Hame

Shortcut keyw: INDHE

Bur: I Marrnal window j

Comment; I

Eind Target... | LChange |con... Advanced... |

()4 I Cancel Amply

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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Type the path to the MAS 90 system using mapped drive.

Click Ok or Apply to save this change.

RF Client Configuration for MAS200

To be able to run RF in the client server modeitis
necessary to copy thefiles from RFS_Workstation folder
to your Workstation (Client) MAS90 folder. After
copying thefilesit is necessary to create rfs_sota.ini filein
the: Client\MAS90\Launcher. It isacopy of origina
sota.ini except that APPLICATION=MAS 200 RFS (this
isareference to aapplication in the application server).
New Application called MAS 200 RFS should be added
into the Application Server Configuration. It isacopy of
MAS 200 application with the following changes:

Application Name: Mas 200 RFS
Lead Program: rfs_startup.m4p

= Application Server Configuration

File Help

Server. | SAGE ﬂ Statuz: | Stopped

Sezzionz ] Server ] Clientz ] Apps ] [zers ] Service ] Loaging ]

=101 %]

| | o |

Type | Dery | Application Mame | Command Line
L [ Mas 200 <arg(Q)x -hd "Startlp 4P
L [T MaS5 200 Link <argQ] -hd "SY_ProcessURL M4

W | Mas 200 FFS <arg(]> -hd "RFS_Startllp M4P"

ol

|:| Include Global Appz

| Detak || New || Delete |

Apply H Exit ]

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
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= Current - App Props for Server: "SAGE™

. —Optiaon

—Applicatior

App Mame:

Providei EXE: | <Defaults

Semver [MI: | <Default:

Lead Progran: | RFS_StartUp. k4P

Entra CWD Options: |

Arguments: |

Start-ln Directon: | <Default:

it i | Marmal ﬂ|
—Llient
Client Type: | Ay Clisrt Type =|
Wind= Yer | 0.00.0000/00 | Mawx Wind=Yer | 0.000000/00
Javk Wer | 0.00.0000/00 M aw Jas Wer | 0.00.0000/00

|:| Dizable Application

Allaws Client Extra CMD Options
Allow Client Arguments

Allaws Client ta Set FID
|:| Allawy Client ta Set Stark-ln Directary

—05 Level

[ ] Detach Spawns via

Drefault Umazsk: Qoo

Mohup

Additional Erveironiment Y ars:

=

I

ok H LCancel }

The following changes should be done in the MAS200

shortcut to launch RF:

INFORMATION INTEGRATION GROUP

457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
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RFS MAS 200 Properties

General Sharteut | I:::umpatil:uilit_l,ll Seu:urit_l,ll

RFS MAS 200

2=

T arget bype: Application
T arget location: Haorme

T arget:

fz_zotaini "RFS Client ARG "GOHAR" "

erfamer' "10000" "'MAS 200 BFS)

£

Start in: I-:: WA S ARDMRFSAMAS 0 Home

Shortcut kew: IN-:une

Bur: I Marmal window j
Comment; I

Eind Target... | Change [con... Advanced... |

] I Cancel Apply

The path of you client system is entered in the Start in
field. Therfs_sota.ini and *rfs_Client are added in the

Target field.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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MAS 90 for Windows CE Launcher

Note: The RF Warehouse Automation security event must
be enabled in the Role Maintenance for the role assigned to
the user in order to allow running MAS 90 for Windows
CE.

ﬂﬁ Role Maintenance (ABC) 12,/13,/2011

Faole FLPET I 4 B B

Dezcnption | supervizor

1 Tasks ] 2 Security Events | 3 Mu:u:luleElptiu:uns] 4 ODBC Seu:urit_l,l]

¥ Allow Purging of Activity Log

¥ Allow Purging of Credit Card Audit Log

¥ Allow to Owvernide Credit Card Authonzation

¥ Allow to Yoid/Re-authonze Credit Card Tranzactions

¥ Allow User to Access File Mantenance Utiliies

¥ Allow User to Access Menu \wizard

¥ Allow User to LockAdnlock Uzers in Uszer Maintenance

¥ Allow Users to Terminate Tazks in Master Conzole [MAS 200 only]

+ Enable Filz Run
¥ Full Access to Private Reports for All Modules
¥ Full Access to Read Only Reports for All Modules
=] FF " arehouze Automation
# Matenal Requirements Planning

=10l x|

=

=

[ Accept I Cancel I Delste Iél@l .

When running MAS 90 for Windows CE, the first screen
you see isthe User Logon screen:

2]

5 .
. -
!

Enter your uger logon name and pazsword,
Logon |

Pazszword

- )

Enter your user logon and password.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
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Then select the Company:

2]

w
o

Select the company vou want to access.

Comparny %

ABC Diztribution and Service Carp.

N 6)

The launcher is opened:

EIPNISTEY

3 Shipping Data Entry

3y Receipt of Goods Entry

3 Irventomy Transaction Entry
i} Physical Count Entry

EARE ]

The MAS 90 for Win CE launcher enables you to work
with Shipping Data, Receipts of Goods, Inventory
Transaction (Transfer and Adjustment) and Physical
Count.

To launch any of these options, select it and click the
Proceed button, or simply double-click the option you
want.

Y ou can aso change the active Company, Date, and User
clicking the icons below.

INFORMATION INTEGRATION GROUP 877.475.4092
457 PALM DRIVE WWW.IIGSERVICES.COM
GLENDALE, CA 91202
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EIPRI=IES

Select the compary pou want to access.

Comparny %

ABC Diztribution and Service Caorp.

Lo e O]

2

E
3
Enter the accounting date for

Purchaze Order.

Lo e [0

The Shut Down button closes MAS 90 for Windows CE.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
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Shipping Data Entry

If Batch Entry is allowed in the Sales Order Options, the
S/O Shipping Batch screen is displayed before opening the
Shipping Data Entry screen.

(5 5,/0 5,0 Shipping E 10| x|
BatchMo| 00001 " [ 14 4 b B
Comment | Frivate Batch [_]

[Mn:ndif_u..l Werify Iﬂenumher.l Mgrge...]
Statuz | Available | C. By
Entrigz 0 k. By

[ Accept I LCancel I Delete IG]

Click the Next Batch Number button to start a new batch,
or enter an existing batch number.

In this case, the batch number is displayed on the Shipping
Data Entry, and can be changed using the Batch Number
button.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
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D1 | &P 230201150 Q
Shp oooo1 |

| Batch Number, 4B

R | 17 -
VB Pkg E
[tern Code |Drdered|5hipped| Back |

1| | H|
o ] =B CEEER)

The Shipping Data Entry screen enables you to enter
shipping data.

{5 Shipping Data En

A

A o ] 3
ID 1 |/ 08/23/20 70 0000174 |G S

Shp 0100058 | Mew 0ooon |- NG \
01-AWHET Aynet Proceszzing Corp

Q g 1B - Shipper ID, Date, Order No, Lookups

S & £, Pka| 0001 |2 4|
|tem Code Drdered|5hipped| Back |
1001-HONH252 | 500 0 .00F .00 Hi

1001-HOW-H254L  2.00 aa .00 Hi
BER0-2E6-16-11 E.00 aa 00 5i

4 | H|
| O |é Adne [ @

S/ID is Shipper ID.

IsClear. Next to it isthe Order No.
First Lookup displays the Sales Order List, to ship the
selected Order. Second lists already entered Shipments.
Shp. isthe Shipping Number and Status.

INFORMATION INTEGRATION GROUP 877.475.4092

457 PALM DRIVE WWW.IIGSERVICES.COM
GLENDALE, CA 91202
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2l-icix
ID[1 || 06/23/207 [ooomi74 (@ %

She 0100058 | New 00001~ IIG

01-2HET Aynet Proceszsing Corp
Qa v . q % =
= & =, Pka| 0001 | ()
Itemd Itern Packaging, Alt-G E.j| Back |

1001-HOM-H252 [ 500 500 .00 Hi
1001 HOM-H2541f 200 200 .00 Hi

BES0-26-16-11 EOD . EOD: .00 SI

1| | H|

Click the Item Packaging (Alt-G) button to open the Item
Packaging Maintenance.

I [=TE
Packane , - % 4 4 & R
@5 -

[tern on Order  [antity an Elljan::k#ity in F'a{
00 [« 500

1007-HOMN-H254L 200 [V 200
BE50-26-16-11 600 [ 600

Accept l Cancel ] Delzte [ﬁ]

INFORMATION INTEGRATION GROUP
457 PALM DRIVE

GLENDALE, CA 91202
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Fapl=TE

ID| 1 |/ 08/23/20 70 | ooooiT4 (G S

Shp 0100059 | Mew ooooz |\ <G
01-AWHET Avnet Proceszsing Corp

Q@_EL 1%7
&1 & £, Pka|0002 [ |

—l Mewt Package Mo, Al iihipped| Back |

1001-HOW-H252 | 5.00 .00 .00 Hi
1007-HOW-H254L  2.00 aa 00 Hi
BE650-26-16-11 £.00 aa 00 5i

“| | H|
| u ||5 Adne [ E]

Y ou can create the Next Package by the help of Next

Package No. button.

2 1o x]
D 1 |~ 08/23/20T7 ooooiTd |G S
Shp 0100063 | New oooot | NG

01-AWHET Aynet Proceszing Corp

% o 4 % >
S5 reon B EID
ltem | Lot/Serial Distribution, & bak ]
1001-HOMH2S4 200 00 .00
BESO-26-1611 | GO0 .00 .00
2551-350 3.00

l |
o Ié Adlne[v]

The Lot/Serial Distribution button is enabled for

Lot/Seria lines.

The Lot/Serial Distribution screen is opened
automatically upon entering the Shipped Qty.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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2| -10| =]
ltem 2481550 | DESKFILE 51/4" CAPE
UM EACH T Fl= -
Lat Numby{ Show &1 Lots, AL jstibute |
JAN1D £5.00 i
MAR10 75.00 00

e | 000D

Digtribution Balance 200

Auto Increment 5

A/lInc. is Auto Increment.
S displays the Shipping screen.

Termz Code | 1]
Confirrn To | IELE=TE]{e]{s] Ck

E-mail &ddr | tonpstEaynet. com

Caomment

Tracking
Warehougze | 002

Shipia | UPS BLUE Q
Ship £one Ck

Ship Wweight| 00000 |G Pkas
Fraht Ammnt .00

The Tracking... button opens the Summary Package
Tracking Maintenance screen.

INFORMATION INTEGRATION GROUP 877.475.4092
457 PALM DRIVE WWW.IIGSERVICES.COM
GLENDALE, CA 91202
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ﬂm Summary Package

2 -10] x|
=% il

Flg | T| FPackage Tracking, ALT-T

00a1 - #aao

The A button on the Shipping Data Entry screen opens the

Ship To Address screen.

Eﬁ Ship to Address

Ship To
M arne
Address

ZIP Code
City

Country

2l

| QL Residential Add[]

[rvine YW arehouze

86 Technology

Building twa

92818

State

IRIME

LSA

INFORMATION INTEGRATION GROUP

457 PALM DRIVE
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The Fast Case Processing becomes enabled in RF when
running the enahncement in the system integrated with [1G
Warehouse Shipping Automation (WSA).

The Fast Case Processing can be used for aline only once
and only before accepting the entry.

Clicking the Cases... button opensthe Fast Case
Generation for the selected line, if there is Quantity
Shipped specified (and if the generation has not been done
before):

3 I TaT
ID|1 || 10247201 [ | 0000003 |Gy S
Shp| 0000013 || Mew 00007 |© i

0Z2-AMERCOMN American Concrete Servi

Q, % Q 18 -
& @ = Pha |00 [ 5
Item Code | Ordered | Shipped | Back |
9264124735 10,00 10.00 .00

— —
x|

Lluantity Per Caze .00

Include Caze 17
Thiz will generate

[ ==

0| caszes.

| —a.

LCancel

Enter the Quantity Per Case. Based on it the program will
calculate the number of cases needed to generate for the
Quantity Shipped. If the Quantity Shipped is not a
multiple of the Quantity Per Case, the quantity remaining
after distributing to the cases completely will be placed in a
separate case (which will remain incompl ete).

[fIIG Fast Case Gene 21 x]
Cluantity Per Caze 5.00

L]

Thiz will generate

2| cazes

[ 0K ] T— ]

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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Check the Include Case 1 box, to include the first casein
the distribution being generated.

If the quantity of the selected line has already been
distributed before starting the Fast Case Generation, the
program will clear the previous distribution.

The generated distribution can be seen in the Item
Packaging Maintenance.

The Item Packaging Maintenance has been modified to
allow more convenient parcel managing.

[F Item Packaging Mai el
Parcels [tems on Order
Package = | | Item I [Iuartiby
noonz
noo3

o004 -
;LI_'*I_I < | ]

Packane Contents
[tem | [Jiantity |
9264-1247-3847-AB. 5.00

]
«
— [termn Mo

Cluiarktity oo ak

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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Packing List Printing

If the Automatically Print Shipping Documents box is
checked on the Main tab of the Shipping Setup Options
program under the Sales Order Setup menu, and the
Shipping Document to Print is set to Packing List or
Both, the Packing List Printing screen is opened when
Accepting Shipping Entry.

ﬂj Packing List Prinking il il

FormCade | STANDA |Gy

Dezcription

Copies 1 j

Multi-Part Farm Enabled[ ]

Print Additional Packing Lists with Contents

Print Camments | Partial |
Charge Itemnsz []

b=gl

bdzg2

Adabe POF hd

[glignment] [ Frink IF"regiewI Setup @

Graphical Crystal printing is available.

If the Addit. Packing Lists box is checked; the
Additional Packing Lists screen is displayed after printing
(or previewing), allowing the user to print the additional
lists.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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Additional Packing List Pri ed
Fom Code | STANDARD |G

Dezcription | (R0l

Copies 'Ilj Collated
Fulti-Part Form Enabled |:|

| #sdiobe PDF =|

[glignment] [ Etint ] Fresvigw lietupl & l

If the Automatically Print Shipping Documents box is
checked on the Main tab of the Shipping Setup Options
program under the Sales Order Setup menu, and the
Shipping Document to Print is set to Invoice or Both, the
S/O Invoice Printing screen is opened when Accepting
Shipping Entry, or after printing Packing List,
correspondingly.

S/0 Invoice Printing ed
Farm | STAMDA |% | Freprinted Lazer |

Copies Collated [v]

Multi-Part Form Enabled [ ]
Comments? m

| ddobe FDF =|

[glignmentl [ Erritit IPFEEiEWI Setup l@l

INFORMATION INTEGRATION GROUP 877.475.4092
457 PALM DRIVE WWW.IIGSERVICES.COM
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Receipt of Goods Entry

If Batch Entry is allowed in the Purchase Order Options,
the P/O Batch Number screen is displayed before opening
the Receipt of Goods Entry screen.

Ei P/0 Receipt Entry E =10f =]
Batch Ma % 44 b K
Comment [ ]

[Mn:ndif_u..l Werify Iﬂenumher.l Mgrge...]
Statuz C. By
Entrigz 0 k. By

[ Accept I LCancel I Delete l@]

Click the Next Batch Number button to start a new batch,
or enter an existing batch number.

In this case, the batch number is displayed on the Receipt
of Goods Entry, and can be changed using the Batch
Number button.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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[F Receipt of Goods E 4 U ] A
Rept | Q[ Batch noooz |

i — | Batches, Al-B |
Date

FO | " v No
Wend Mo, | | ! T

PO St 1 Step
Purch. Addr. |:| - Required |:|_
ShpTo | |-
T#Sch, :
Terms :I 3
| mn Usze Tax |:|

ld 4 & B [gcceptl Cancel I Delete ]

The Receipt of Goods Entry screen enables you to enter

and review receipts of goods.

Enter Receipt Number in the Rcpt No. field or click the #
(Next Number) button to create new receipt.

[fReceipt of Goods E 21 =1 x|

7= Batch |ﬁ|

PO | " Inv.No

"-.J'enl:I.ND.l T o
PO St 1 Step
Purch. Addr. |:| - Required |:|_
ShpTo | |-
T#Sch. :
Terms :I 5
| mﬂ se Tax |:|

I 4 & Bl [gcceptl Cancel I Delete l

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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[fReceipt of Goods 21 =1 x|

Reopt 001012 - [0 Bateh 00002 °

Date | 0642372011

PO 0010019 | Inw. Nal 122333

Yend Mo, 01-SLLCLIM |- | DB/A23/200 |

&llclimate Maintenance PO St Mew

Purch. Addr. | W Ck Required | 3/2011 :
Ship To | 0000 C% ABC Distributing Co

T/Sch. | DEFAULT % Default Tax Schedy

Terms QL NET 10

| mﬂ Lse Tax |:|

I 4 & Bl [gcceptl Cancel I Delete l

Y ou can navigate through the orders using standard
navigation arrow buttons at the bottom of the screen.

TheH, A, L, T buttons open Header, Address, Lines,
Totals screens respectively. These screens correspond to
corresponding tabs of the Receipt of Goods Entry screenin
the standard MAS 90.

Here is the Header screen opened with the H button:

2 x]
1099 Form | Here hd

1099 B o x|

Whee | OO0 %

Ship¥ia | 1IPS RED Q,

FOB

Comrment

Confirm | Kirk Taylad

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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Click the A button to display the Purchase Address
screen:

[F Purchase Address il |

REUTR il Call
Addrezs | 2331 Trinity Dirive
Suite 1601

ZIP | 92626 State | CA
ity Coszta Meza |
Country | LISA, Ck

Phone | (714] 6661015 00|
Fax | [714) B6E-1000

The Ship To button in this screen opens the Ship To
Address screen:

[ Ship To Address ed

Mame | ABC Distributing Compary
Addresz | 3191 AIRPORT LOOP

ZlF 92626 State | CA
City COSTA MESA

Country | USa |G

The L button on the Receipt of Goods Entry screen
displaysthe Lines screen:
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x

] Do pou want ta receive the
‘--fr) complete purchaze arder?

R
== EER-
[temn Code Elrdered|Fieceived| IJnit Cozt
1001-HOM-H29 500 RO0 34280

[S4BBESON 300 200 545300

2868-3-25 2.00 200 5&75.800
A0 i a0

| | b

LT::-taI.-'i‘-.mDunt| 5,95:3,?5” ok, ]

If an item has Lot/Serial Number, the Lot/Serial
Distribution button allows opening the Lot/Serial No.

Distribution screen:

Enter the lot or serial number for the distribution, or click
the Lookup button to list all available lot numbersto be

distributed.
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[ Lot/Serial Numbe cd U | A

[tern | 2480-8-50 DESK FILE 8" CaF 50

I | CASE J._ . 5':'23 @ - E
Lot Murmber | Ayailable | Drigtribite |
101 97.04
10210 2.00
JaM10 3.25
MaR10 8.80 .on
oo oo
Digtribution Balance .00

mar=e)

At the Distribute field, enter the total lot or serial number
amount to be distributed.

YR P |EEFE -
Eh'= 5 -
[temn Code Elrdered|Fieceived| IJnit Cozt

1001-HOMN-H24  5.00 500 34250
2420-3-50 2.00 200 545300

2PE3-3-25 200 200 &FR.800
GEMDTHA, | 200 200 275850
o a0 .aao

| | b

T atal Amount 251045 (]

For Serial Itemsthe Select Serial Items button is available;

INFORMATION INTEGRATION GROUP 877.475.4092
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2| -10] x|

ltem |GE-MDYE0 | MODEM 3600 [SYMCHR

U/ | EACH = 4=
Select Senal Mumbers, Alt-5 | Lovailable | Diiztribte |

Q) .00

Dhiztribwtion B alance 2.00

ar=e)

Y ou can click the Select Serial Numbers button to salect
the available serial numbers for the item or warehouse to be
distributed.

Y ou can also click the Add Serial Numbers button to
create new serial numbers for items that are being added
back to stock. The Add Serial Numbers task is available
only for seria items.

[F Add Serial Numbers d bl

[tem Code | GB-MD 7RO
YWhee 00

Starting Serial Mo. | SER#O0|

[ oK. ]gan.:e| ]@]

It is necessary to enter only the Starting Serial No. and
sequential Serial numbers are automatically created based
on the Serial Item total quantity received.
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[tern | GE-MDYS0 | MODEM 3600 [SYHCHR

IJsw | EACH % 5':'2@ TG

Serial Mumber | Ayailable | Drigtribite |

SER#001 oo
SER$#002 oo
oo

Digtribution Balance .00

mar=e)

[ Lot/Serial Numbe cd U | A

Y ou can aso add new items directly on the Lines tab of the

Receipt of Goods Entry.

Enter an item number that doesn’t exist in the Inventory

Management.

r%|_Dﬂ s|@ |l |

&
[temn Code Elrdered|Fieceived| IJnit Cozt
1001-HOM-H29 500 RO0 34280

r— —

2480-850 200 200 545300
2568-3-25 200 200 575.800
GE-MD750 200 200 .275.850
ME'_ITEM .00 .00 000

o |

4
Tatal Amt 851045 [ ][ ]| Ok

When pressing Enter, the following message box will
appear asking whether or not to accept the new or Alias

Item.
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x

i Iz thiz a new [nventory [tem

Code?

| [ s |

Upon clicking Yes, the Item Maintenance screen will
appear for new item entry (Item number is the one entered
on the Lines tab of the Receipt of Goods Entry).

x|

Item | MEW ITEM
Copy From | 1001-HON |G, | EEETIEIES (=

lLr-:u:I Ln wia G WORKSTATION FURI

Fid T | Firished Goot ~|/Wal| FIFD =

P. Code STD QL Froc. Buy -

l‘-.-'v’rnt. Ck

Bt Cst 52,500

StPr 131.000

PrUM [EAC Q, No.of EACH 1

Sls /M| EAC @, No.ofEACH 1

Ftd I1¢m EACH Ck Image | abc_10 Lﬂ ‘

Y ou can use Copy from lookup button to copy the fields of
already existing items for the new one.

After filling in item related information in this screen and
clicking Accept, you will be returned to the Lines tab of

the Receipt of Goods Entry.
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% |oR  s|@| B -

Q EH-E5-
|tern Code I:Irdered|Heceived| it Cost
1001-HOM-H24 500 500 34250
2480850 200 200 545.300
2568325 200 200 575.800
GE-MD7E0 200 200 275850
NEW TH® | 200 200 82500
| i oo 0o

1| | 3
Total Amt 567545 ][] OK

For Alias Items (when you click Alias button on the
message box asking whether or not the entered itemisa
new item), the newly added Alias Item Number
Maintenance screen will be displayed.

[ Alias Item Maintenan

Aliaz lkem Mo

ALlASHO0M

2l xi

Yendar ﬂ
07-ALLCLIM

Type
YWendor

Item Na | 10071-HOM-H252

[tem Description

Aliaz Item Description
ALLCLIM Aliad

HOM 2 DRAWER LETTER FLE /O Lk

o

I

LCancel l

Upon clicking OK you will be returned to the Lines tab
with the selected Item No automatically loaded into the
Item Code field in the data entry.
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2l x|
'“‘*a:-|_D.H 5| @1 e - ‘
QR ER-EB-

[tem Code I:Irdered|Heceived| It Cost
1001-HOW-H29 500 ROD 34.250

2480850 200 300 545300
2RER-3-25 200 200 575800
NEW_ITEM | 200 200 82500
O0THON® | oo o0 3420

| oo 00000

4
Total &mt 512375 [][]| Ok

If the Job Cost (or Work Order) module is integrated with
Purchase Order, the fields related to Work Order become
availablein the lines grid:

= |mR 2@l B -
Q & -E5-
[tem Code Warehnus&lnst|"-.-'-"u:urk I:Irder|er
K.EYBD-00102 | 000 5 0095015 T

VGAI-42954 | 000 FoDasig |7

4 [ 5
Tokal 2183.00 (]| ok

Enter the Work Order number representing the work order
to which you want to distribute the cost associated with the
line item. Click the Lookup button to list all work order
numbers.

Enter the Step number for the selected work order against
which you want to distribute the cost associated with the

INFORMATION INTEGRATION GROUP
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line item. Click the Lookup button to list all step numbers
for the current work order.

Select a Transaction Type to be used to record the cost of
thelineitem. Thisfield isavailable only if awork order
number or step number was entered

Click the T button on the Receipt of Goods Entry screen
to display the Totals screen:

T axable Purchases a0
Maontaxable Purchases 8.675.45
Freight Amoint | .00
Sales Tax Amount .00
Irwaoice Tatal 2.675.45
Prepayment &xvailable .00
Frepayment Applied .00
Prepaid Check Mumber

Hold Paprnent []

[I__anl:led I:Dst...| Tay Detail... l
| Add Totals | 0K |

N/Tax. stands for Non-Taxable,
S/Tax for Sales Tax,

P/Pmnt Prepayment,

and P/Paid for Prepaid.

Hld Pmnt stands for Hold Payment.

The Landed Cost button opens the Landed Cost Entry
screen:

INFORMATION INTEGRATION GROUP
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e T
ok T_I,Ip{:u:rip|1eth Arnount |
FRGHT Frei 25.00
2 0

Total Landed Cost Z5.00

[ 1] l LCancel L

The Add. Totals... button in the Totals screen opens the
Totals Additional screen:

Em Totals Additional ilil
CODNumber | |

Lesz COD Amaunt .00 |
COD Check Ma
[rvoice B alance 612375 |

Inwoice Due Date | OF /0420011
Digcount 0 ate 070442011

Digount Amoint 2.00
Frepaid Freight 20.00

Bank Code ' - Security Pacific Checki

INFORMATION INTEGRATION GROUP 877.475.4092
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'“?2:-|Q_H s @[ B - ‘
| QA EREES-

Iterm Code Drdered|F|eu:eived| it Cost
1001HONHZ| 500 500 34.250
2480-8-50 300 200 545300
2568325 200 200 575300
MEW ITEM | 200 200 82500 ++NEW++ and ++AUTO++
1001-HONHZ] .00 00 34250
a0 00 000
| | k)l

Tatal At E.123.75 | I Ok

RFS Receipt of Goods works with bar code scanners.

If the New box is checked, the program will add itemsin
new lines irrespective of their presence in the existing lines.

If the Auto Increment box is cleared, the program will find
line with this item and select that line. Y ou can increase the
quantity in the line manually.

If the Auto Increment box is checked, the program will
automatically increase the quantity of the item in the line
where the received quantity does not exceed the ordered. A
new line will be added only if there is no such line.

Y ou can either check these boxes with the mouse or type in
++NEW++ or ++AUTO++ respectively in the Item

Number field.
INFORMATION INTEGRATION GROUP 877.475.4092
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|nventory Transaction Entry

The Inventory Transaction Entry screen allows entering
Transactions of the Transfer and Adjustment types.

2| =101 x|

Tranzaction Type | INEGEEE

| |
Entry Murnber %

Tranzaction Date

Tranzfer From "Warehouse

Transfer To %W arehouze
Comrment

Linesz

4 4 F K [ECDEPt I Eancell Qeletel

Select Transfers in the Transaction Type drop-down list
and click the Next Entry Number button.
Enter the Transfer Date, Transfer From and To

Warehouses, and Comment.

Tranzaction Type | Transfers |
Enty Mumber 00000009 [

Tranzaction Date | 06/25/2011 :
Tranzfer From Warehouze | 000 Ck
CEMTRAL WAREHOLUSE

Tranzfer ToWarehouse ooz Ck

WEST wWaREHOUSE
Comrment

Lines

4 4 @ W [ECDEPt I Eancell Qeletel
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Y ou can navigate through the Transactions using standard
navigation arrow buttons at the bottom of the screen.
Click the Lines button to open the Transaction Lines
screen.

x|
Y |er[ @@

I —
|EB B! =B

[tem Code To'whae | Fran
2480-8-50 IJEIE &, | 000
2
1| | r

Select an Item or its General Alias. The To Warehouse is
defaulted from the header and may be changed for
particular line. Enter the Quantity to be transferred, and
click OK.

If theitem is Lot/Serial, the Lot/Serial Distribution screen
IS popup.
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[ Lot/Serial Numb cd U | A
[tern | 2480-8-50 DESK FILE &' CaP &0
A | EACH J._ | 5':'33 @ - &
Lat Numl:uer| .ﬁ.vailal:ule| Distribute |
1 101 9.702.00 2.00
R
3| JaM10 323.00 2.00
4 | MaR10 850,00 0o
] 0o 0o
Diztribution Balance 0o
)

Enter Lot(Serial) Number, and quantity to Distribute.
The List button opensthe list of all the Lot(Seria)
numbers. Use the & button to distribute all the quantity to a

selected Lot Number.

Select Adjustments in the Transaction Type drop-down
list and click the Next Entry Number button.
Enter the Transaction Date, Default Warehouse, and

Comment.

[F Transaction Entr

Trangaction Type | Adjustments

Entry Hurmber Qo000

Tranzachon Date | 0642942011

Drefault ‘W arehouze Qoo
CEMTRAL wWaREHOUSE

Comment

Lines

2l =101 %]
O

E

a

14 4 b bi [2eospt] Cancel| Deere |
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Click the Lines button to open the Transaction Lines
screen.

[if Transaction Lines X

2480-3-50 T, Lot Mo
DESE FILE 8" CAF &0
114 YWhee [luantiby
EACH 000 T
IInit Cozt E stenzion
15.656 1.3
2480-8-50
EACH 000 [.000
1001-HOM-H252
EACH 000 2.000 33500

e

For items with LIFO/FIFO Valuation, the distribution
screen is displayed on entering the quantity.

[ Distribution Entry g
[kem | 1007 -HOM-H2540LE.
Unit of Measure | EACH

FIFO Drate 0341542010

Receipt Mo, | BC-0707
Ay ailable 10.00
Diiztribute 7

Distribution Balance 00

For items with Lot/Serial Valuation, the distribution screen
is displayed on entering the quantity.
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[\ Distribution Entry ed
[tern | 2481-5-50
Init of Meazure | EACH

Lot Murnber
kR0
Ayailable 325.00
Diistribute a7

Digtribution Balance .00

Physical Count Entry

In the Role Maintenance select the RFS Physical Count
Entry task added to the Inventory Management
Miscellaneous Tasks menu to enable accessto RFS
Physical Count Entry for the current role.

sxe Role Maintenance (ABC) 9/8/2014

Role Admin SR VP RN

Descrption | Admin

1 Tasks 2. Securty Eventz| 3. Module I:Iptil:unsl 4 SData Security] 5 ODBC Securit_l,l-

= ¥ Miscelaneous Tasks ﬂ
& Automatic Cost and Price Chanoe

B alarize GQuantity On Hand

Beqginning Balance Recalculation for deverage Cost [kems

Correct Short IM1 Records

Delete and Change [tems

[/t Setup 'Wizard

[tem Y aluation Change M aintenance

[tem Y aluation Change Selection

Purge tem Hiztory

R ecalculate [tem Histary

R emove Zero Quantity Costing Tiers

RFS Physical Count E niry ;I

A A A I A Y Y S A A A

[ Accept I Cancel I Delete ldEblOl
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On the Physical Count Entry screen, enter the Warehouse
Code, and select if you wish to see all lines frozen or just
the lines you will enter.

sx¢ RFS Physical Count E x|
[ iRFS Physical Count Er
Warehouse %

CEMTRAL WAREHOLSE

Shaow Only Mew Lines

Y ou can navigate through the Warehouses using standard
navigation arrow buttons at the bottom of the screen.

Physical Count Entry requires that products be frozen
using the Physical Count Worksheet program similar to
how the standard Physical Count Entry program works.
However you normally only see what you counted to speed
counting and reduce errors in counting.

Click the Lines button to open the Physical Count Lines
screen.

There are two versions of the line screens. Thefirst screen
isthe standard screen if the MBN moduleis not installed or
activated for the selected warehouse. Thisis Item Code
Only screen. Counts are by Item only.

The second version of the screeniswhen [1G's MBN
moduleisinstalled and is active for the selected warehouse.
Thisisthe Bin/ltem screen. Counts are by Bin Location
and ltem..

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
WWW.IIGSERVICES.COM



RF Warehouse Automation 4.50

43

x
[tem Ecu:le“ |%
Bin Loc. | |
Ok
Item Code | Laot/Ser ... | I:::uunted|

.

Item Code Only screen.

The Lookup button opens the Item List screen.

2l =10l x|

|tem Caode i
DR&WE

1001 -HOM-H 252LF. HOM 2 DRAWE_
1001-HOM-H254 HOM 4 DRAWEI
1007 -HOM-H 254LE, HOM 4 DRAWEI
2480-8-50 DESK FILE 8" C.
2481-5-80 DESK.FILER1A
2851-3-80 DESK FILE 314
2BE8-3-25 DESK FILE 314
4886-15-14-3 FARER CADDY
BER0-26-16-11 SOUMD CVR 26
BESZ-28-24-15 SOUMD CVR 28
BERR FRINTER STAMN
BER7-24-20-12 SOUMD CVR 24
3953 UMNIWERSAL 31T
1| | 9

leIt...“j Search [ ViEWSlﬁelect]Eancell

| Found 80 rec | | |

Item Bin Location will be displayed for the selected item.
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x
Itern Cade | 1001-HON-H252 (=N

BinLoc. [E-300-10 |

ok

Item Code | Laot/Ser ... | I:::uunted|
1001-HOM-H252 5.00

.

If the Incr. box is cleared, the program will find the item
and select that line. Y ou can increase the count manually.
If the Auto Increment box is checked, the program will
automatically count up the item just after entering/scanning
the Item Number.

Y ou can enter/select the Item number or it's General Alias.

If the 11G UPC moduleisinstalled scanning the item’s
UPC code or the ITF-14 case code will select theitem. If
the ITF-14 case code is scanned the program will increment
by the standard UOM conversion factor. So if the ITF-14
isfor example a case of 12 and the standard UOM is
EACH, the program will count 12 instead of 1. Thisis best
used with the Incr. field checked.

If the selected Item is Lot/Serial, all the Lots (Serials) of
theitem are listed.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
WWW.IIGSERVICES.COM



RF Warehouse Automation 4.50

45

Select alot item from the Item List.

x
Item Code | 2450-8-50 (=N

Bin Loc. ||:-1nn-1u
a0

Item Caode | Lat/Ser ... | I:n:nunted|
1001-HOM-H252 5.00
2480-8-50 Jak10 1.00

P

Enter lot number in the Lot Number field and click Enter.
If the entered Lot Number existsin thelist it will be
selected, otherwise new Lot Number will be added in the

list. The lookup will show you the lots for the selected
warehouse.

x
Item Code | 2450-8-50 (=N

BinLoc. [C-100-10 |

Loser oA, [0x ]
Count 1.00

Item Caode | Lat/Ser ... | I:n:nunted|
1001-HOM-H252 5.00
2480-8-50 Jak10 1.00

P

If the Incr. box is cleared, the Lot number with a 0 count
will not be added. Y ou must inter the count manually.

If the Auto Increment box is checked, the program will
automatically increase the count of thelot.
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Enter ++Auto++ in the Item Code field and press Enter to
check/uncheck the Auto Incr. box automatically.

Physical Count with MBN

Bin Loc. || |% [ Clear ]

[tem I:|:u:|e| | g

(e
Bin Loc

| Counted | L

£

lH

| [tem Code

1| | |
s ] Forp il

When MBN isinstalled and the warehouse is enabled for
bin locations, the Physical Count Lines screen changes to
the Bin Location/Lines format.

Y ou must select the bin you are counting. An additional
check box (Keep Bin) will retain the Bin Location selected
and flow the scanning back to the Item Code to speed
scanning and counting of the products in the bin. When
you finish counting the bin, click on the Clear button to
reset the bin. Y ou can select by lookup or by scanning the
binif the binis bar coded.

Note: We suggest that you click Accept at the end of each
aisle to update the counts entered. Remember that nothing
is posted to the MAS count files until Accept is clicked.
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Bin Transfer Entry

The Bin Transfer Entry menu becomes enabled when
running RF Warehouse Automation in the system
integrated with Multibin Processing:

=10l

i+ Shipping Data Entmy

iy Beceipt of Goods Entry

i lrwentary Transaction Entry
i+ Physical Count Entry

[ FProceed [ﬁhutDDwnl‘

Bin Transfer Entry allows transferring items from one
Bin Location to another within the same warehouse.
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Eﬁ:l,.-"M Bin Transfer Enktr ;lglil

Modify... ||Benumber|| ey berge. ..
Batch Ma | %E’B 4 4 b Rk

Comrment |

Frivate Batch [ ]

Status

Entries ]
Created By
bodified By

[gccept l Cancel l Delete I 61

This entry functions the same way asin Multibin

processing:

(% Bin Transfer Entry (ABX) il |

Entry Mo| 000000000¢" - [
Batch | 00003 °

@R[ 1@ |ER==E-

wehc*ltem I:::u:Ie| From Ein |t_l,l To T|

2 .0a

(KN Al

Ayeailable Quantity in 4420040 Biniz -3 Ed

Keepwhaev| Keep It k.eep From Bin+|
i 4 B B Aocept | Cancel | Delete
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[ Bin Transfer Entry (ABX 2=l

Entry Mo| 0000000005 ! [
Batch | 00003 |°

[ 2@ [="H==E-
||rehc4ltem Code| From Bin |t_l,l To T|

1 |00 2480-86C 4420040, 1.00 A
@, | 2480-850 4420040, .00

(KN — I

Arallable Cluantiby in 4820040 Biniz -2 E4

Keepwheev] Keep It K.eep From Bin[«]
4 4 B ki Accept | Cancel | Delete

Bin Inquiry
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Lookupsin RFS

Lookups in the RFS enhancement enable all the
functionality the standard MAS 90 lookups have (except
for the Zoom button). The starting symbols can be entered
before clicking the Lookup button to narrow the displayed

itemslist.

[ Item Lisk

|tem Caode
1001-HOM-H2

1001-HOMN-H282LK

1001-HOM-H254

1001-HOMN-H254LK

2420-8-50
2481-5-50
2551-3-50
2068-3-25
4886-158-14-3
BERO-2E-16-11
BE5Z2-258-24-15
BES5
BEG/-24-20-12
2353

4

|F_i|t... [] Search[] "v"iewsl Select |Eancel

HOM 2 DRAWE
HON 4 DRAWEI
HON 4 DRAWEI
DESKE FILE 8" C.
DESK FILE 51/
DESE FILE 31/
DESE FILE 314
PAPER CADDY
SOUMD CVR 26
SOUMD CVR 28
PRIMTER STAN
SOUMD CVR 24

UMIWERSAL 31T
F

| Found 80 rec |

TheFilt... button enables setting Filters.

2 =10] x|

Colurmn

| Operand | Yalue

1 [tzm En:u:leJ

-]

* | Beqginz j248

-]

Save Fiters [ ]
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After applying thefilters, the Filt... button appears red.

2l

|term Cod

2 1
2431-5-50

1] | i
[Fjlt...] [] Search[ ] ViEWSl Select |Eancel
|F|:|ur'u:| 2 rect | | |

Check the Search box to specify search criteriain the
displayed fields. Click Find to search with the entered

criteria.

2] (5]
|tem Caode i | D'ezcription ﬂ
1001-HOM-H252 HOM 2 DRAWE
1001-HOM-H252LE. HOM 2 DR&WE]
1001-HOM-H254 HOM 4 DR&WE]
1001-HOMN-H254LE. HOM 4 DRAWEI
2480-8-50 DESE FILE 8"
2481580 DESEFILER 14
2551-3-60 DESK FILE 314
28R8-3-25 DESE FILE 314
4386-18-14-3 PAPER CADDY =
4 I I ]
Itern Code || Begins with hd

25

Find
Filt... Search| | | Select |Eancel

|F|:|ur'u:| a0 rec | | |

Check the Views box to work with lookup views.

Select aview from the View drop-down box to switch to

that view.
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[ * Item List I ]
|tem Caode i | D'ezcription ﬂ
1001-HOM-H252 HOM 2 DRAWE
1001-HOM-H252LE. HOM 2 DR&WE]
1001-HOM-H254 HOM 4 DR&WE]
1001-HOMN-H254LE. HOM 4 DRAWEI
2480-8-50 DESE FILE 8"
2481580 DESEFILER 14
2551-3-60 DESK FILE 314
28R8-3-25 DESE FILE 314
4386-18-14-3 PAPER CADDY =
4 I I ]
Wiew “Brief hd

“Birief
|Fj|t... [] ViEWSl Select |Eancel

|F|:|ur'u:| a0 rec | | |

If there is no custom view, the View drop-down box is not

visible.

EIpI=ES
|tem Code i | D'ezcription ﬂ
1001-HOM-H252 HOM 2 DR&WE
1001-HOM-H252LE. HOM 2 DRAWEI
1001-HOM-H254 HOM 4 DRAWEI
1001-HOM-H254LE. HOM 4 DRAWE]
2480-8-50 DESKE FILE 8"
2481580 DESE FILER 14
2501-3-60 DESE FILE 314
2A68-3-25 DESE FILE 314
4886-18-14-3 FAFER CADDY =
1 | | 3
|F.i|'i--- [ ] UlEWSl Select |§ancel
|F|:|ur'u:| 3 rec | | |

Click Cust... button to create a new or change an existing

view.
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ﬂ& Lookup Customization i' il

Select view parameters for Lookup.
Company ABC, Uzer G

Wiew | Create new wiew ﬂ|

D escription | |
Default Wiew

[ Delete l l Mest » l I LCancel l

Select or modify the colurmls).
Company &BC, Uzer IG Yiew - Brief

Available Fields Selected Columnz

- StandardUriit] = | @ * |tern Cade

- Standardl mitF Description

: WarrantyCode
- LastT atalllnitl
ast oAl @ StandardUnit0 de:
- BeragellmitC

; TarClazs
- S alesPramotic

- Suggested e
- SalezPromotic

- Totalluantityl @
- AvaraneR ark

i O e

[NewFisid..| 7= |{= ][ bodiv. |

[ <Back |[ mest> |[ Finish |
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Heading |
Width ]
Justification
Mask L HEE A HHO00-
Caleul field | &1

ok LCancel

ﬂm, Calculated Field Bui

nnaann
Available Fields
Itemlmage'w'inﬂ
ltemlmageHe
i StandardUritl

- StandardUrni
- LastTotalUnit »

| »

[ﬂ] [ ok ] [Eancell
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[F Lookup Customizatio ed
Enter ar modify the filkerlz].
Company &BC, Uzer IG Yiew - Brief

Calurnn

1
2

[ 44

1| | *
[ < Back |[ Wewt> ][ Einish |
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Appendix
An example of RFSInstallation on handheld devices

1-Microsoft Active Sync should be installed on the computer:

1-Download:
http://www.microsoft.com/downloads/details.aspx?FamilylD=7269173A-28BF-
4CAC-A682-58D3233EFB4C&displaylang=en
(If thislink didn’t work easily open www.google.com and search for “Download
Microsoft Active Sync”)
2-Click on Run

File Download - Security Warning

Do you want to run or save this file?

|—m MHame: setup.exe
Type: Application, 6,93ME

From: download.microsoft,com

Run J [ Save ] [ Cancel

i | While files from the Intermet can be uzeful, thiz file twpe can
I L’j potentially harm your computer. [F pou do not truzst the source, do not
= run or gave this software. What's the rigk?

3-On Welcome Page Click Next
4-Accept License Agreement and click next
5-Enter Customer Information and click next
6-Choose Destination folder and click next
7-Install...

8-Finish

2-After Installation of Microsoft Active Sync connect your PDA to the computer using
USB Cable and select Guest Partnership (No) and click next.
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Mew Partnership

Set Up a Partnership

Before vou can synchronize information between your
riobile device and thiz camputer, you must set up a
partnership between them.

Wiould you like to get up a partnership?

(O ves

Set up a partnerzhip so that | can synchronize
infarmation between my device and this comprker.

| don't weant bo synchronize infarmation. Set up my
device az a guest zo that | can copy or move
infarmation between my device and this complker.

< Back L_ﬂe:-cb ][ Cancel ] [ Help ]

3- In order to make connection between handheld device and Citrix server, Citrix ICA
client for windows CE hasto be installed on PDA:

1-Download Citrix ICA client for Windows CE on your computer:
http://www.citrix.com/site/SS/downloads/details.asp?dID=2755&download ID=3602
(If thislink didn’t work easily open www.google.com and search for “Citrix ICA client
for windows CE”)

2-Installation:
1-Run cesetup.exe
2-1t will ask for installation path:

Installing Applications El

Inskall "Cikrix Systems ICA Client” using the default application install directary

Cancel |

3-Click on “No” button
4-following screen will pop up:
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x|

Save In: b ain b emary j

kd ain b emary
| Platform
Space TE gLy
Space available.  er. TS .

k. I Cancel

Choose “Application” option from drop down list and click “OK” and follow the
installation on PDA screen to complete the installation. It will add two iconson PDA’s
Programs screen:

5-finish

4- Configuration of RFS on Handheld Device:
1-On handheld Device Click on Start then Programs
2-Choose ICA Client

l.;"_{.w'r ' Programs o3 oz 3216 9
Adr [ -
BEAM I
Games AirBEAM Calculator
Client

» [3

File Explorer ICA Client UT NN [T

Settings
wis
¥ & P
Microsoft SN Pictures

Reader Messenger —
% ¥ W

Pocket Excel Pocket MSN Pocket —
Word i

E|A
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3-Create New Connection

£ Internet Explorer  +F < 3:16 9

L)

bttp:ff127.0.0, 1fmain.htm -| @
E Main

Create Mew Connection
Pl Agent Properties
Edit Global Settings

| Connect | | Edit | | Delete
Bbout Citrix (8 Client For Mindows CE

view Tools ¢ £ (3 <% E|A

4-Enter the Citrix Server |P address

l.;'E;" Internet Explorer o =2 3:43 9

http:ff127.0.0.1fserver htmPvCreat - | @
E Main = Mew Connection > Server

Settings
Server or Published Application:
192,168,111.120

Refresh Servers
Refresh Published Applications
Server Locakion

| Save | |Eancel|

view Tools ¢ € o3 <% E|*
5-Save
6-Edit

877.475.4092
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7-Edit Application Settings

.,F.F Internet Explorer 4 =2 3:53 9

http:ff127.0.0.1fapplication.htrmay = | @

|E| Main = Edit 192,1658.111,120

Settings = Application Settings

Application:

Working Direckary:

| Save | |Eanl:el|

view Tools ¢ £ (3 <% E|A

8-1n this step you need to know the MAS 90/200 running address on Citrix Server. So,
Login to the CITRIX Server and Right-click on the MAS 90/200 program Shortcut and
select properties then write down the Address in Start-in path.

According to Shortcut address on Citrix Server fill the Application and working
Directory fields:

Application: your path\M A S90\Home\pvxwin32.exe -hd ..\launcher\sota.ini
.\s0a\RFS_Startup.mdp

Working Directory: your path\MAS90\Home

(Where your path stays for the path to your MAS 90/200 Start-in path, e.g.
D:\MAS\MasA50\Rfs).

10-Save
11-Click on Edit link and click on Edit Logon Information.
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*,frwj Internet Explorer  4F {2 4:10 9

http:ff127.0.0.1{login.htrm?vbame  « [ @

E Main = Edit 192.165.111.120

Settings = Logon Information

Username:

Password;

Darnain:

| Save | |Eanl:el|

Yiew Tools <@ @ < E|*

12-Enter your Citrix server logon Username, Password and Domain and saveit.

13-Click on “Edit <citrix server |P address> Settings’ link and click on “Edit Windows

Settings”

i i CAFRY
1 £ -
l.,Ej Internet Explorer o ={£ 4:14 9

http:ff127.0.0.1fwindow . htm?vMa - - | @

e
|z| Main

= Edit 197,168,111,120 Settings
= Window Settings (Absolute Size in
Pixels)

Window Colars:

Zhange ko Fit ko -
Screen

Inikial Display Scale Factor:

Initial Panning Position:
Ton | oft

Yiew Tools <3 ‘é T E|A

-

14- Click on “Changeto Fit to Screen” link and saveit.
15- Finish
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Sample
For the setup of Symbol MC9090 handhelds

AD Prep and Documentation

Allocate the handheld’s IP address, HH username, and hostname. Place adhesive labels
on the handheld using the format “HH<##f> <hostname> <IP address>".
Update info on the Handheld IP’s Excel Spreadsheet.

Initial Handheld Setup

1. Immediately place the unit in the charger to ensure the backup battery becomes fully
charged. Once the handheld is charged, proceed to the next step, removing the
handheld from the charging unit. (Charging will be more rapid if the handheld unit
remains powered off.)

2. Click on the Start button and set the system time.

3. Enter the hostname of the handheld and its description.

e Go to Start > Settings > System tab > About > Device ID tab > Device name:

e (In the Description field, input the HH user who will be using the handheld.)

e Click OK to exit.

4. From the main screen, disable 802.11d wireless access by using the Wireless Options
tool.

e Select the wireless icon on the lower right of the screen, and then select Options
from the pop-up menu.

e From the drop-down menu, select “Regulatory”, then clear the “Enable
802.11d"” checkbox.

e Click Save to save changes, then Exit.

5. For P3 handhelds only — Enable both 2.4 GHz and 5.0 GHz bands for wireless
connectivity.

e Select the wireless icon on the lower right of the screen, and then select Options
from the pop-up menu.

e From the drop-down menu, select “Band Selection” and ensure that both “2.4
GHZ Band” and “5 GHz Band” are selected.

e Click Save to save changes, then Exit.

6. Connect the handheld to your company wireless network

e Select the wireless icon on the lower right of the screen, and then select “Find
WLANSs" from the pop-up menu.

e Once the scan for WLANSs has finished, select and hold your stylus over the
“yournetworkname” WLAN, then select Connect to initiate the connection
wizard. Enter the following settings:

0 Profile ID — accept both defaults, which should be “yournetworkname”.
Click Next to continue.

0 Operating Mode — accept both defaults, which should be
“Infrastructure” and “Allow Any Country”. Click Next.
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7.

0 Authentication — accept default “none”. Click Next.

0 Encryption — use the drop-down menu to select “40-Bit WEP”. Accept
the default Key Index of 1 and leave the “Use Passkey” checkbox
unchecked. Click Next.

O 40-Bit WEP —replace the password fields with 10 lowercase a’s: aaaaa
aaaaa. Click Next.

O IP Address Entry — Use the drop-down menu to change the option to
“Static”. Click Next. Enter the IP Address and Subnet Mask, then check
the Advanced check box. Click Next. Leave the G/W field blank, enter
DNS server info, and leave the WINS field blank. Click Next.

0 On all remaining screens, accept all defaults. You will then be back at
the Manage Profiles screen. Click OK to exit.

0 If you are prompted with a pop up box that says “Establishing
Connection”, choose the “Work” connection.

0 On the lower right corner of your screen, you should see your wireless
status indicator either in red, yellow, or green, indicating the strength of
your wireless signal.

Test connectivity to your LAN.
e Click on the wireless status icon in the lower right corner of your screen and
select “Wireless Diagnostics” from the popup menu.
e Select ICMP Ping.
e Inthe IP field, enter 172.16.1.1, and click on Start Test.
e Monitor the Total Tx and Total Rx indicators to ensure you are able to ping the
company gateway.

Installing The Datawedge Application

1.

Place the handheld in a charger and connect the charger via a USB cable to a computer
that has Microsoft ActiveSync installed.
Upon your computer’s registering the connected mobile device, navigate through the
Active Sync wizard, indicating that there is nothing you want to synchronize. If your
system does not connect to the handheld, try adjust the “USB to PC” setting on the
handheld. By default the “Enable advanced network functionality” checkbox is checked.
You should uncheck it if you experience any connectivity issues.
e Go to Start > Settings > Connections tab > USB to PC
Go to your computer, and select the “Explore PocketPC” option from the Tools menu of
Active Sync. This will open an Explorer window into your handheld.
Copy the appropriate Datawedge components, as excerpted below from Symbol’s
documentation:
e Unzip the DataWedge download package (if necessary) into a temporary folder
on the PC.
e Copy “\Bin\PPC\DataWedge.exe” from the PC to the \Application folder on the
device.
e Copy “\Application\DataWedge.cpy” from your PC to the \Application folder on
the device.

INFORMATION INTEGRATION GROUP 877.475.4092
457 PALM DRIVE WWW.IIGSERVICES.COM
GLENDALE, CA 91202



RF Warehouse Automation 4.50 64

8.
9.

Browse to the \Application\Bin\PPC\DataWedge.exe file, hold the stylus on the file until
the popup menu appears, and select Copy.

Paste the shortcut into the Windows\Startup folder on the handheld. (If you cannot see
the Windows folder, you may need to enable the option to unhide hidden and system
files on your computer.) Then manually launch Datawedge by selecting it while you are
still in the \Windows\Startup folder.

Click on the DataWedge icon in the lower right corner of your screen, and from the
popup menus, go to Barcode > Prefix/Suffix.

Check the checkbox that says “Send ENTER key after suffix”

Click OK to exit.

10. Test the scanner by opening Word Mobile and performing a test scan.

e Go to Start > Programs > Word Mobile

e Click on New to create a new document if no other test document is available.

e Scan a barcode and observe the data in Word Mobile. Each successive scan
should be on its own line.

e Exit until you get the handheld’s main screen.

Installing the Citrix ICA Client

1.

From your computer make sure that the handheld has been able to reconnect to your
computer, and run the Citrix CE client program, cesetup.exe. Click OK when prompted.
Your computer will now display a message stating that you should check the handheld
for any further messages to finish this installation. Click OK and proceed to your
handheld...

Your handheld should now be asking you a location to which you want to install the
Citrix client. Accept the default, which should be “Device”, then click “Install” on the
lower left corner of your screen.

Click on “I Accept” to accept the license agreement.

After the program installs, you will receive a confirmation message that installation was
successful. Click OK to exit.

Warm boot the handheld to verify that DataWedge loads on startup.

Disconnect the handheld from the cradle and terminate your Active Sync session, as
wireless access may be disabled while connected to Active Sync.

Connection Settings For Wireless Citrix Environment

1.

vk wnN

Open the Citrix ICA client configuration utility.

e Go to Start > Programs > ICA Client
From the main menu, select PN Agent Properties.
Select “Enable PN Agent”.
In the Server URL field, enter the IP address 172.16.1.195, then click on the Save button.
If the connection is made, you will be presented with a Login Details screen. Enter the
below details:

e Username: the HH<##> ID of the handheld.

e Password: the default password.

e Domain: “your domain name”
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Check the “Save Password” checkbox, and then click OK.

When the screen refreshes, scroll down and click on the Save button one more time.
At the top of that screen, click on the “Main” hyperlink.

Click on Edit Global Settings.

. Click on Edit Preferences.

. Scroll down to the “Enable Full Screen (No Local Taskbar)” checkbox, and check it.

. Scroll to the bottom of the screen, and click Save.

. Click the X to exit.

. You should now be at the Programs Screen. Click the X to exit to the Main screen of the

handheld.

Setting up a Connection to MAS

1.

A

Notes

1.

Configure the appropriate menu settings.

e Go to Start > Settings > Personal tab > Menus

Scroll down the Menus page until you see the “T200” icon, and select it. Click OK to exit.
The T200 icon should now appear on the Start Menu.

Click on the T200 icon to initiate a connection to MAS.

Enter the appropriate User ID and corresponding password.

If this is the first time you have connected to MAS using this handheld, MAS will prompt
you for the company code you wish to access. Enter the Company Code and select OK.
You should now be at the MAS 90 for Win CE main menu. Select Shut Down to exit
MAS. You will be returned to the handheld’s main screen.

In the event that the handheld is cold booted, most (if not all) of the setup steps will
need to be repeated. A warm boot will cause no loss of settings.

When resetting after a cold boot, make sure to rename the handheld to the
appropriate hostname BEFORE configuring the Citrix environment. This will aid
in not causing duplicate terminal server licenses from being issues to the same
handheld. Also make sure the handheld is not connected to Active Sync.
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